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Introduction 
 
• What is a database? 
 

A collection of related information organized so that analysis and reporting are easy-to-handle functions. 
 
• When should you use a database? 
 

When there is a need to store and manipulate data to provide information. 
 

• How is a database different from word-processors and spreadsheets? 
 

Word processors Work with text, graphics, publishing on paper 
 
Spreadsheets Numbers, complex tables (multilevel headings), scenarios, data modeling, statistical 

analysis 
 
Database Use the same data for many purposes; store non-quantitative information about a subject 

and report it in a variety of ways; see and work with various subsets of information; track 
a process or project 

 

Kinds of databases 
 

Flat 
• Information in a single list 
• Only one table contains the information 
• Easily sorted and examined  
• Example:  Telephone book (Last name, first name, address, phone number) 
 

Relational 
• Information in several tables 
• The same field occurs in several tables to connect or “relate” the data. 
• Complex information 
• Example:   Student Registration 
 

Courses Sections Registrations Students
Course ID Term Student ID Student ID 
Title Course ID Term Student Name 
Credits Section # Course ID Address 
Etc. Instructor ID Section # Telephone 
 Etc. Etc. Etc. 
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Open and close databases 
 

 

Double-clicking on this icon will open the Access database called Basic Contact 
Mgt.mdb. 

 
 

The Database Window 
 

 

Ask a Question box 

Objects Pane 

 
Objects Descriptions 

Tables Data collections in rows with column fields 
Queries Requests to retrieve data 
Forms Formatted displays of table data for updating or viewing. 
Reports Presentations of data for printing 
Pages Displays shortcuts to data access pages 
Macros Sets of instructions to automate actions 
Modules Blocks of code to perform complex procedures 
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Toolbars 
 

Database toolbar  
 

 
 
 

Table Datasheet toolbar 
 

 
 

Icon Name Function 

 Datasheet View Displays table as a datasheet.  Icon displays when design view is 
selected. 

 Design View Displays design of table, allows changes.  Icons displays when 
datasheet view is selected. 

 Sort Ascending Initiates sort in ascending order 

 Sort Descending Initiates sort in descending order 

 Filter by Selection Displays records which match contents of selected field 

 Filter by Form Displays records based on criteria entered into a form 

 Apply/Remove Filter Applies filter to select records 

 Find Finds a record based on a specified criteria 

 New Record Initiates process to add new record 

 Delete Record Deletes currently selected record(s) 

 Database Window Displays database window to access reports, queries, tables, etc. 
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Formatting (Datasheet) toolbar: 
 

 
 

Icon Name Function 

 Gridlines Style Changes settings for display of horizontal and vertical gridlines 
in datasheet view. 

 Special Effect Applies raised, sunken, or flat appearance. 

 

Filter/Sort toolbar: 
 

 
 

Icon Name Function 

 Save As Query Allows the current filter to be saved as a query for later use. 

 Clear Grid Clears criteria from previous filter. 

 Apply/Remove Filter Applies filter to select records. 

 

More on Filters: 
• Filter by form or filter by selection methods are available using either datasheet or form view. 
• Used primarily for temporary viewing or editing of data. 
• Always a good idea to "Clear Grid" before starting.   
• Filters can be saved as queries.  For more info, consult the Office Assistant, using "save a filter" as the 

search string. 

Navigation 
 

 
Icon Name Function 

 First record Positions to first record in table 

 Previous record Positions to previous record in table 

 Next record Positions to next record in table 

 Last record Positions to last record in table 

 New record Gets next available key and clears fields to enter new record.  

 

 6 



Instructional Technology Center 

Shortcut keys to navigate in Datasheet view 
 

Going to a specific record Press 
Move to the record number box; then type the record 
number and press ENTER  

F5 

Navigating between fields and records Press 
To move to the next field TAB, ENTER, or RIGHT ARROW  
To move to the last field in the current record, in 
Navigation mode 

END 

To move to the previous field SHIFT+TAB, or LEFT ARROW  
To move to the first field in the current record, in 
Navigation mode 

HOME 

To move to the current field in the next record DOWN ARROW 
To move to the current field in the previous record UP ARROW 
Navigate to another screen of data Press 
To go down one screen PAGE DOWN 
To go up one screen PAGE UP 
To go right one screen CTRL+PAGE DOWN 
To go left one screen CTRL+PAGE UP 

Datasheet View 

Change column width 
 

Method Change Width Best Fit 
Click right border at top of 
column 

Drag either left or right Double click 

Right click on column heading 
and choose Column Width 

Specify width in number of 
characters 

Click Best Fit button 
 

Format | Column Width Specify width in number of 
characters 

Click Best Fit button 
 

 

Reasons to change column width 
• Reduce size of columns to see more columns on the screen. 
• Enlarge size of columns to see all the data.  

Move Columns 
Change the position of columns in order to see what is most important. 
1. Click once on the column header. 
2. Click again on the column header holding down the left mouse button so that a box appears at the end of the 

pointer.   
3. Move the pointer until a double black line appears in the desired location. 
4. Release the mouse and the column will move. 
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Freeze Columns 
If there are many columns in the table and you want to freeze one or more columns to identify the record: 
1. Select the column or columns OR 1. Click in the column you want to freeze. 
2. Right click in the selected area. 2. Choose Format | Freeze Column. 
3. Choose Freeze Columns 
 
The frozen column(s) will move to the leftmost position in the datasheet. 
 
To unfreeze the columns: Choose Format | Unfreeze All Columns 

Hide Columns 
If there are many columns in the table and you want to hide some of them from the datasheet view: 
1. Select the column or columns. OR 1. Click in the column you want to hide. 
2. Right click in the selected area.  2. Choose Format | Hide Columns. 
3. Choose Hide Columns. 
 
The hidden column(s) will disappear from the datasheet. 
 
To unhide the columns:  Choose Format | Unhide Columns.  Then select the columns that you would like to 
redisplay. 

Reverting to Original Column Layout 
If you do not want to keep any revisions to the column arrangement permanently: 
1. Close the table. 
2. Click “NO” when you are asked if you want to save the changes to the layout of the table. 
 

Add records 
• Records are added in datasheet view at the end of the table. 
• Save added records or modifications by moving to another record, or by hitting <shift+enter>. 

Input masks, data entry rules, or links to other tables. 
• Input masks are used to make data consistent 

Phone number mask ( ___ ) ___-____ 
Date Mask  __/__/__ 
Social Security Number ___-__-____ 

• Data entry rules are used to prevent inappropriate or out-of-bounds information to be added. 
 >0   Value must be greater than zero 
 Between 100 and 999 Value must be in the range 100-999 
 “A” or “B” or “C” Value must be either A or B or C 
• If a field is linked to another table, the value must be in the other table before it can be inserted. 

 8 



Instructional Technology Center 

Shortcut keys to navigate in Form view 
 

Go to a specific record Press 
To move to the record number box; then type the record number 
and press ENTER 

F5 

Navigate between fields and records Press 
To move to the next field TAB 
To move to the previous field SHIFT+TAB 
To move to the last field in the current record, in Navigation mode END 
To move to the first field in the current record, in Navigation mode HOME 
To move to the current field in the next record CTRL+PAGE DOWN 
To move to the current field in the previous record CTRL+PAGE UP 
Navigate in forms with more than one page Press 
To go down one page; at the end of the record, moves to the 
equivalent page on the next record 

PAGE DOWN  

To go up one page; at the end of the record, moves to the equivalent 
page on the previous record 

PAGE UP 

 
 

Notes: Additional shortcuts are available.  Just click on the Office Assistant and enter ‘keyboard shortcuts’. 
 

Data entry tips 
 

To move the insertion point… Click in the field, then press… 
One character to the right/left RIGHT/LEFT ARROW 
One word to the right/left  CTRL+RIGHT/LEFT ARROW 
To the end of the field, in single-line fields  END 
To the end of the field, in multiple-line fields CTRL+END 
To the beginning of the field, in single-line fields HOME 
To the beginning of the field, in multiple-line fields CTRL+HOME 
Undoing changes (also refer to note below on “Undo changes”) Press 
To undo typing  CTRL+Z or ALT+BACKSPACE 
To undo changes in the current field or current record; if both have 
been changed, press ESC twice to undo changes first in the current 
field and then in the current record  

ESC 

Entering data in Datasheet or Form view Press 
To insert the current date CTRL+SEMICOLON (;) 
To insert the current time  CTRL+COLON (:) 
To insert the default value for a field  CTRL+ALT+SPACEBAR 
To insert the value from the same field in the previous record CTRL+APOSTROPHE (') 
To add a new record CTRL+PLUS SIGN (+) 
To delete the current record CTRL+MINUS SIGN (-) 
To save changes to the current record SHIFT+ENTER 
To insert a new line CTRL+ENTER 
Refreshing data after adding/deleting records Press 
To refresh data so that all new records are accessible SHIFT+F9 

 
Notes: If the insertion point isn't visible, press F2 to display it.   
 Additional shortcuts are available for data entry.  Refer to the online help for keyboard shortcuts. 
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Undo changes when adding or editing records 

• Click Undo on the toolbar to take back your most recent change.    
• Click Undo Saved Record on the Edit menu if you have already saved changes to the current record, or have 

moved to another record.  
 

Note:   As soon as you begin editing another record, apply or remove a filter, or switch to another window, you 
will not be able to use these methods to “undo” changes. 

 

Filtering Records 
 
Filters provide an alternative to locate records that match criteria in certain fields.  For example, a filter could be 
used to identify those with an address in Pennsylvania, or those with a grade point average greater than 3.0.   
 
The Filter/Sort toolbar changes, depending upon the most recent action.  Some of the icons from this toolbar are: 
 

 Filter by Selection.   Filter by Form 

 Applies the filter, or if a filter is currently applied, removes the filter. 

 

Filter by Selection 
1. In a field on a form or datasheet, find one instance of the value you want records to contain in order to be 

included in the filter's results. 
2. Select the value, and then click Filter By Selection on the toolbar.  
3. Repeat step 2 until you have the set of records you want. 
4. To remove the filter, click Remove Filter on the toolbar. 
 
Note:  You can also filter for records that do not have a certain value. Select a value, right-click on it, and then click 
Filter Excluding Selection. 
 

Filter by Form 
1. Click Filter By Form on the toolbar to switch to the Filter By Form window. 
2. Click the field in which you want to specify the criteria that records must meet to be included in the filtered set 

of records. 
3. Enter your criteria by selecting the value you're searching for from the list in the field (if the list includes field 

values), or by typing the value into the field.   
4. If you specify values in more than one field, the filter returns records only if they contain the same values you 

specified in each of those fields.  
5. Click Apply Filter on the toolbar to filter the records. 
6. To remove the filter, click Remove Filter on the toolbar. 

Note:  For more information on filters, click on the Office Assistant and enter ‘filter data’. 

Getting Help 
OnLine Help 
The Office Assistant is available from the Help menu to provide answers to your questions.  Help is also available 
from the Contents, Answer Wizard, or Index, but you must first turn off the Office Assistant.  To turn off the Office 
Assistant: 

1. Right-click on the Office Assistant and choose Options. 
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2. Deselect “Use the Office Assistant”, then click OK. 
 
After turning off the Office Assistant, choose “Microsoft Access Help” from the Help menu.  Click Options, then 
Show tabs to access the Contents, Answer Wizard and Index tabs. 
 
If you turn off the Office Assistant, you can access it by selecting “Show the Office Assistant” from the Help menu. 
 

Queries 

Designing a query in the design view: 
 

1. Select the Queries tab. 
2. Click on New. 
3. Select Design View. 
4. Select the table to be included in the query and click Add.  Repeat for additional tables. 
5. Click Close. 
6. Add fields to the query grid using one of the following methods. 

• Click on field name in the table box and drag to the field line in the grid. 
• Double click on the field name in the table box. 
• Click on the field line on the query grid and select a field name from the drop-down list. 

7. Adjust information on the Sort, Show, and Criteria lines. 
8. Click on the Run icon to run the query.   
9. If changes are needed, click on Design icon to return to the query design window. 

10. Close window.  
11. Click Yes to save the changes. 
12. Name the query in the Save As box.

Query Design Window 
 

 
Query Design Window 
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Sort 
• The query may be sorted in either ascending or descending order by one or more fields. 
• Click on the Sort line in the column to be sorted and select the desired order. 
• Sorting is done from left to right. 
• Fields may need to be rearranged to obtain the desired sort order. 

Show 
• The square box on the Show Line should be checked if the field is to appear in the query. 
• If the field is not to appear, the check should be removed. 
• Reasons for a field not to appear. 

The field is used just for sorting. 
The field is used for criteria selection only. 

Criteria 
 
• The criteria line is used to limit the selection of records to those with particular values. 
• For example, if the listing were to include only those persons living in Pennsylvania, then PA should be inserted 

on the Criteria line in the State column. 
• Automatic additions by Access after you press enter: 

Quotation marks (“) are inserted around text. 
Number signs (#) are inserted around dates and times. 
“Like” is inserted before wildcard expressions. 
“Is” is inserted before “null” or “not null”. 

These can be inserted directly, if you prefer. 
• Expressions can be used on the Criteria line. 
 

Symbol Meaning Examples 
=   
(Optional—can be omitted) 

Equal “PA”, =100 

< Less Than <50 
> Greater Than >0 
<= Less Than or Equal <=#12/25/96# 
>= Greater Than or Equal >=”M” 
<> Not Equal <>”Indiana” 
Between --- and --- Between a range Between #1/1/97# And  #12/31/97# 
* Wildcard of 1 or more Like “(412)*”,  Like  “*shaw” 
? Wildcard of 1 character Like “5?5”, Like “sm?th” 

 
• If the entire expression is not visible, Shift F2 will show the expression in a Zoom Box. 
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Multiple Criteria: AND vs. OR 
 
• The criteria for a selection may combine AND and OR relationships. 
• Specifications on different criteria lines create an “OR” relationship. 
• More than one specification on an individual criteria line creates an “AND” relationship. 
 
Examples: 

OR:  This selection will include 
Grimshaw OR  
Peacock OR  
any record with a Work Phone starting with (412). 
  

 
Example illustrating selection using OR 

 
AND:  This selection will include  

Grimshaw  AND a Start Date after 7/10/97 OR 
 Peacock AND a Call Date after 7/10/97 OR 
 any record with a Work Phone starting with (412) AND a Call Date after 7/10/97 
 

 
Example illustrating selection using AND 
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Total Line 
 
You can add a total line to the query grid by: 
 
• Clicking on the Totals icon  

 
OR 

 

 
 

• View | Totals 
 
Some functions available on the Total Line: 
• Group By   -   Default 
• Sum 
• Count 
• Avg 
• Min 
• Max 
 
The number of fields in a Totals query should be limited to the field or fields that are being grouped and the field 
that is being totaled.   
 
Access changes the column name of the field being processed to the function and the name of the field, such as 
TotalOfSalary or CountOfProducts or AvgOfPrices. 
 

 
Example resulting in the number of calls for each contact 

 
 

 
Results of example illustrated above 
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Creating Reports 
 
To create a new report in Access, click the New button on the Reports object view to display the various options: 
 

 
 
 

New Report Method Description 
Design View Create a report on your own 
Report Wizard Wizard automatically creates the report based 

on selected fields. 
AutoReport: Columnar Wizard creates a columnar report (titles in 

column along left margin) in one step based on 
a table or query. 

AutoReport: Tabular Wizard creates a tabular report (titles on top) in 
one step based on a table or query. 

Chart Wizard Wizard creates a chart based on a table or 
query. 

Label Wizard Wizard creates a report in label format based 
on a table or query. 

 
 
For the AutoReports, the Chart Wizard, and the Label Wizard, a single table or query must be selected in the New 
Report box.  Since the Design View and Report Wizard enable you to use more than one table or query, you do not 
have to specify a table or query on the initial New Report box. 
 
The AutoReports are excellent for creating a quick report based on one entire table or query, or for creating a base 
report which you can further customize. 
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Report Wizard 
The Report Wizard creates an automated report with more flexibility in selecting the fields, format, and sorting. 
 
1. You can select specific fields from one or more table or query. 

 

 
2. You can specify grouping by a particular field or choose not to have any grouping.  In the diagram below, 

grouping by Contact Type was selected from the box at the left. 
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3. Additional grouping levels may also be selected.  In the diagram below, we are grouping by Contact Type and 
then by State or Province. 
 

 
 
 

4. You can specify a sort order of up to four fields, either ascending or descending. 
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5. You can specify the layout of the report as listed in the diagram below.  
 

 
 
 

6. You can select a style.  Bold is indicated in the diagram below. 
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7. The final step is to give the report a title.   
 

 
 
 

8. The start of the completed report based on these selections looks like this: 
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Label Wizard 
Labels can be easily generated from a database: 
 
1. Click the New button on the Reports tab. 
2. Select Label Wizard, then select the data source.  The data source can be a table or query. 

 

 
 

3. Select the label manufacturer from the pull-down list, then select the label size and sheet type. 
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4. Select font and color. 
 

 

 
5. Select the fields desired for the label.  Text can be added between fields, such as the space added between First 

Name and Last Name below and the comma and space inserted after  City. 
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6. A sorting field can be selected. 
 

 
 

7. You’ll be asked to name the label report. 
8. Access creates the labels in the proper format as shown below: 

 
 

 
Note:  If you’ve selected three-across labels, you may see the following error: 
 

 
 

According to Microsoft, this message is a warning and you can safely ignore it. You should not experience any loss 
of data when you print the labels. 
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Printing Tables and Reports 

Tables, Queries, Forms, and Reports can all be printed by using File | Print or the printer icon.  
Using the File menu to print will provide you with the Print options dialog box.  
 

Print Preview 

To get a preview of the printed page, click on the Print Preview icon.  The Report objects view 
of the database window has the option to go directly to Preview.  

 
The toolbar for the print preview has a number of options: 
 
 
 
 
 

 

Two Pages – 
Displays two pages 

at a time. 
Zoom – Toggles 

zooming in and out 

 
 
 
 
 
 
 

 

Export or
 
Often it may
 
1. Click on
2. Select d
3. From th
4. Locate t

the "Sav
5. Using th
6. If "Save
7. Select "
8. Click on
 
Note:  A que
automaticall
file saved in 
recommende
control over
 

 

Select specific 
viewing 

percentage. 

One Page – 
Displays one page 

at a time. 

Multiple Pages – 
Displays up to six

 copy query output into an Excel spreadsheet 

 be useful to export a query to Excel so that it may be manipulated in spreadsheet format.  To do this: 

 Queries in the Objects list. 
esired query. 
e File menu, choose Export. 
he folder where you wish to save the spreadsheet.  Select the folder so that you see the folder name in 
e in" box. 
e "Save as type:" pull down list, select "Microsoft Excel 97-2002 (*.xls)" from the list. 
 Formatted" is not selected, select it. 
Autostart" if you want to start Excel and open the new spreadsheet. 
 Export. 

ry can also be exported using the Office Links button on the toolbar, however, this method 
y saves the spreadsheet in your default directory, which is generally the O drive.  Keep in mind that any 
the O drive will be available to anyone in your office.  If your data is confidential, it is strongly 
d that you use the steps outlined above to export a spreadsheet.  This will provide you with greater 
 where the spreadsheet is saved. 
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Linking to Tables in another Database 
 
IUP is developing databases with historical information about budgets, enrollments, revenues, etc.  Authorized users 
will be able to read the data, but will not be able to change or manipulate the original data.  In order to use the 
information, a new database must be created that can access the information. 
 
Ways to obtain information from another database: 
• Import the data 

The data is loaded into a new database.  
The data becomes part of the new database and can be changed.  
Adjustments to the original data are not reflected in the new database.  

• Link the data 
 The data is "attached" or "linked" to the new database. 

The linked data cannot be changed using the new database; it may only be change in the database that 
contains the data. 

 Any adjustments to the original data are reflected in the new database. 
 
It is preferable to link the data. 
 

Steps to create a new database that links to data in another database: 
1. Open Access. 
2. From the File menu, choose New. 
3. Choose “Blank Database” from the New File task pane. 
4. Click OK. 
5. In the file New Database box enter information about the new database: 

Save in:  drive or folder name 
File Name: name of new database 
Save as type: Microsoft Access Databases (*.mdb) 

6. Click on Create. 
7. Select Tables from the Objects list, then click New. 
8. Select Link Table. 
9. Click OK. 
10. In the Link box locate and highlight the name of the database to be linked to. 
11. Click Link. 
12. In the Tables box highlight the table names to be included in the new database or click Select All. 
13. Click OK. 
14. In the new database, the tables will appear with an arrow at the left of the table icon to indicate a linked table. 
15. Set up your own queries and reports from the linked table.  You cannot change the data, but you can select from 

it, arrange it, sort it, and list it any way you prefer. 
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Getting Help 

OnLine Help 
The Office Assistant is available from the Help menu to provide answers to your questions.  To turn off the Office 
Assistant: 

3. Right-click on the Office Assistant and choose Options. 
4. Deselect “Use the Office Assistant”, then click OK. 

 
You can access the Office Assistant by selecting “Show the Office Assistant” from the Help menu. 
 
Another new feature in Access 2002 is the Ask a Question box.    This box allows 
you to quickly enter a question or phrase to search for help on that topic.  The 
online help will display items related to your search phrase. 

 
 

 

Recommended Reference Books 
Microsoft Access 2002 – Step by Step (Online Training Solutions, Inc.) 
Using Microsoft Access 2002 – Special Edition (Que) 
 

Microsoft Office Web Site 
http://office.microsoft.com/assistance
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